Brand Strategy
We are advocates.

We are there for our AAA and Title VI members every day. We support, bring together, and represent our members and offer them a national voice. We are advocates for our members so they can continue to do important work for older adults, people with disabilities and caregivers in communities across the U.S.

This is the key theme of our brand. We always keep it in mind and it should come through in everything we produce. This is an internal statement.
**Mission**

*Our purpose for existing. This is an external statement.*

**USAGing represents and supports** the national network of Area Agencies on Aging and advocates for the Title VI Native American aging organizations that help older adults and people with disabilities live with optimal health, well-being, independence and dignity in their homes and communities.
Vision

Our hope for the future we will create. This is an external statement.

USAGing believes that every person should be able to age with optimal health, well-being, independence and dignity in their homes and communities. To achieve this, we are committed to building a society that values and supports people as they age.
Positioning

The place our brand occupies in the minds of our target audiences, and how we distinguish ourselves from our competitors. This is an internal guide.

We are the national association for Area Agencies on Aging across the U.S., supporting, uniting and advocating for our members. We also serve as an advocacy voice in the nation’s capital for Title VI Native American aging programs.

Our members serve their communities in many ways, assisting older adults but also younger people with disabilities, people with early onset dementia, grandparents raising grandchildren, and caregivers of older adults.

We work closely with our members to identify and seed the latest innovations and address the ongoing challenges of providing life-changing services to older adults and people with disabilities across the country. We make sure the great work being done at the community level is represented at the highest levels of power in Washington, DC, and work with policymakers, funders and other stakeholders to continually improve the home and community-based services that promote healthy aging.
Value Proposition

The unique and key benefit for our audiences. This guide is for internal use.

We are an **advocate, leader, resource and united voice** for our members, so they can better support those they serve.

We **advocate** for our members so they can support older adults as they age with health, well-being, independence and dignity at home and in the community.

We are a **resource** for our members, identifying, sparking and seeding the latest innovations and opportunities and supporting them as they rise to meet ongoing challenges. We support our members through resource sharing, best practices, education, peer networking, and training and technical assistance.

We **lead** a national network of locally rooted organizations with a **united voice**. They give us our credibility; we give them access and representation in Washington, DC.
Promise

Our goal for every experience our audiences have with our brand. Consistently aligning with this statement strengthens our brand. This is an internal guide.

We lead.

How do we fulfill this promise?

• We **support** our members, understand their successes and their challenges, and ensure that the latest information and local insights guide our leadership on a national level.

• We **organize** and **position** our members to explore and launch innovative and locally developed aging services so that older adults, people with disabilities and caregivers around the country have the opportunity to age well.

• We **advocate** on behalf of our members, and those whom they support, with federal policymakers and national leaders. Our advocacy is guided by the collective perspective of our members around the country, and we actively work to secure the essential resources needed to continue their important work.

• We **educate** our members about new challenges and opportunities so they can continue to grow and succeed in an evolving world.

• We **envision** a future where all Americans can age with health, well-being, independence and dignity at home and in their communities.
Pillars

The principles that we communicate through our brand. We should always align with these values in every communication. These are internal statements that should guide our external content.

Advocacy

USAging is the only organization that speaks on behalf of all AAAs and those whom they support and is a national advocate for Title VI Native American aging programs. USAging does not take this responsibility lightly, as millions of older adults, people with disabilities and caregivers depend on the critical services provided by our members around the country.

Local Commitment

USAging’s leadership is made possible by our close relationships with AAAs, and their collective expertise in helping older adults and people with disabilities live with optimal health, well-being, independence and dignity. The policies, funding and initiatives that USAging supports all tie back to the ultimate goal of improving and expanding essential services and supports to those in need.

National Connection

As the national leader of the AAA network, USAging brings together AAAs from across the country to speak with a united voice and to strengthen aging and home and community-based services. We also advocate for and champion Title VI programs in the nation’s capital. As such, USAging is a national resource on data, trends, innovations, best practices and policies related to the Aging Network in general and the AAA and Title VI network in particular.

Expertise

Our credibility as a national advocate and united voice comes from our members who are rooted local leaders in aging and community living. We exist to support our members—by providing guidance and resources, and sharing our expertise on national trends, program development and policy.

Innovation

We are committed to leading our association and our members to drive change through innovation and best practices in the field of aging. To do this, we identify and seed innovations through our work and recognize and celebrate the innovations of our members.

Community Living

We believe everyone has the right to be able to live and age at home and in the community. Successful community living should be accessible to all—no matter one’s age or ability—and reflect what is needed to age with optimal health, well-being, independence and dignity. Our members provide the local services and supports that enable this. Respect, compassion and equity are core principles to who we are as an association.
Persona

Our persona consists of the traits our brand embodies. While elements of our persona should be present in our external content, these personality trait descriptions are an internal guide. Sometimes we may lean more on certain traits and decrease the visibility of others, depending on the audience and the context.

We are:

**Passionate**
We are determined and enthusiastic advocates on behalf of our members and the older Americans and people with disabilities whom they serve.

**Inspirational**
We believe every person should be able to live with the best possible health, well-being, independence and dignity at home and in the community and should be able to access the support they need to do this, regardless of age or ability.

**Inclusive**
We are inclusive of a broad range of members, which are in turn serving people in all areas and of any background. When applicable, we always include AAAs and Title VI organizations in our work.

**Trusted**
We are the trusted leader and advocate for our members at the national level; as such, our voice has credibility with national policymakers, other national organizations and the private sector.

**Supportive**
We understand the common challenges of our members, and work to address those challenges by offering training and technical assistance, sharing new best practices and connecting professionals across the country. We are empathetic, helpful and responsive.

**Knowledgeable**
We are experts. We are thought leaders, helping pave the future of aging. We are informed, credible and smart. For policymakers, we are the source of knowledge on the national and local issues our members know and care about. For our members, we are a voice, a resource and a guide on best practices, services, trends and more.
Persona continued

When communicating, keep in mind these attributes as a guide and resource.

We are:

- Respectful
- Relatable
- Experts
- Inclusive
- Smart
- Professional
- Determined
- Confident
- Active

- Leader
- Advocates
- Trusted
- Compassionate
- Thoughtful
- Conversational
- Supportive
- Authentic
- Energetic

We are not:

- Playful
- Irreverent
- Edgy
- Complex
- Trendy
- Small
- Casual
- Aggressive
- Quirky
Voice
The voice we speak in. Use this as an internal guide for external communications.

Unified
USAGing speaks in a clear, confident and focused voice on behalf of AAAs and Title VI organizations around the country. We unite a broad and diverse membership base on common issues and speak with authority and clarity on their behalf. We present a unified voice for our members and a collective front in our brand.

Trustworthy
USAGing is trusted by our AAA and Title VI members. We listen closely, understand deeply and represent with integrity to safeguard this trust. We treat our members and these issues with the seriousness and passion they deserve. We speak with clarity and accuracy.

Expert
USAGing understands its role as an important source of information. For policymakers, USAGing is the voice of our members; for our members, USAGing is a trusted source for updates on federal policy developments and their impact on AAAs and Title VI organizations, as well as best practices, programs and services, and more. USAGing’s voice should be detailed, useful, accurate and well-informed.

Passionate
We speak with energy and heart. We are positive, optimistic and compassionate. We allow our passion to shine through by being neither too casual nor too formal. We care deeply about these issues as people serving people.
Tone of Voice

While our voice remains constant, our tone may need to change depending on the audience or context. Always consider who your audience is, and how to communicate most appropriately with them using our voice.

With our **members**, our voice should strike tones of support, education and leadership. We actively listen to our members, their successes, their challenges, and respond with leadership and expertise. We speak as experts and as a trusted resource for innovation and best practices, pushing our members forward.

With **partner organizations**, our voice should be informed, confident and constructive. We’re confident in our area of expertise and our role as the trusted national voice for AAAs. We also value learning from perspectives other than our own, and appreciate the progress made possible by working with outside partners.

With **policymakers**, our voice should be credible, constructive and locally connected. Our role as the national representative of AAAs and advocate for Title VI programs is a major factor in our political credibility. Our solutions are scalable in nature, but driven by insights at the local level, and aimed towards ultimately improving essential services provided to older adults, people with disabilities and caregivers. We speak as experts and are a trusted resource on aging and community living.
Writing Guidelines

We communicate in **plain language**, using simple, straightforward language and sentence structure, and avoiding jargon and needless complexity. This makes us more direct, effective and approachable. Always write for the audience first.

We speak in the **active voice** for more simplicity, clarity and authority. Avoid the passive voice unless it is absolutely necessary.

When speaking as an organization, we speak in the **first-person plural**, using we, us, our and ours. This makes us more inclusive and welcoming. It keeps our audiences involved and engaged. When content is coming from individuals, it should be written in the singular first person, using I, me, my and mine to be more approachable.

For clarity and consistency, we adhere to our style guide in all of our content.
Brand Narrative

Our population is growing older and living longer, and we stand united to help Americans of all ages and abilities age with the optimal health, well-being, independence and dignity at home and in the community. We are the national association of Area Agencies on Aging (AAAs) and an advocacy voice in the nation’s capital for Title VI Native American aging programs. We are the leading advocates for local leaders on aging. Together, we are ensuring all of us can live well longer, today and in the future.

We provide information, resources and advocacy tools for our members so they can develop, coordinate and provide aging and community living services in communities across the country. We are their voice in Washington, DC, and we look to the future to help our members continue to grow and adapt to changing needs and markets. We bring these local leaders on aging and community living together, we represent them, we tell their stories and we make them stronger individually and collectively.
Brand Narrative continued

Our History:

For nearly 50 years, USAging (formerly n4a, the National Association of Area Agencies on Aging) has represented Area Agencies on Aging (AAAs) as they work to ensure every American can age with maximum health, well-being, independence and dignity. AAAs were established in 1973 as part of a reauthorization of the Older Americans Act (OAA). In 1978, funding targeted to Native American Tribes was added, thus creating Title VI of the OAA. The association, n4a, was formed in 1975 to advocate and represent AAAs in Washington, DC; Title VI Native American aging programs became eligible n4a members in 1988. Advocacy remained the association's primary mission until 1992, when n4a was awarded a grant from the U.S. Administration on Aging to establish a national call center to connect older adults and their caregivers to needed services at the community level; the Eldercare Locator remains administered by USAging today. Since the early 2000s, USAging has also grown its work in research, training and technical assistance—conducting landmark surveys, and operating several national resource centers that are building the capacity of AAAs and other aging and disability entities at the local level. These include the National Aging and Disability Transportation Center, the Aging and Disability Business Institute, the engAGED Resource Center, and the USAging-administered Dementia Friendly America and Dementia Friends USA. Our work continues to evolve to support our members in new and emerging areas, to help them better serve older adults, people with disabilities and caregivers, now and in the future.
Description of USAging

The way we talk about ourselves to new audiences, such as via letters, publications, websites, etc. This is an external statement.

Mandatory 1st section

USAging is the national association representing and supporting the network of Area Agencies on Aging and advocating for the Title VI Native American Aging Programs. Our members help older adults and people with disabilities throughout the United States live with optimal health, well-being, independence and dignity in their homes and communities.

Optional 2nd section

USAging and our members work to improve the quality of life and health of older adults and people with disabilities, including supporting people with chronic illness, people living with dementia, family caregivers and others who want to age well at home and in the community. Together, we are ensuring that all people can age well.

Our members are the local leaders that develop, coordinate and deliver a wide range of home and community-based services, including information and referral/assistance, case management, home-delivered and congregate meals, in-home services, caregiver supports, transportation, evidence-based health and wellness programs, long-term care ombudsman programs and more.

Optional 3rd section

USAging is dedicated to supporting the success of our members through advancing public policy, sparking innovation, strengthening the capacity of our members, raising their visibility and working to drive excellence in the fields of aging and home and community-based services.

Notes on the Description

The first section must always be used. The second section (both paragraphs) may be used with or without the third section, and the first and third sections may be paired absent the second section, depending on context of the usage.

Staff may also convert this text into third person language (“its members”) ONLY if the situation requires it, but it is USAging’s brand to use first person.
Elevator Pitch

General
We are USAGing, the national association of Area Agencies on Aging and an advocate for the Title VI Native American aging programs. Our members are the local leaders on aging across the country and help ensure that older adults can age with optimal health, well-being and independence in their homes and communities and that their caregivers have the support they need. We are the united voice of these local leaders on aging.

For AAAs and Title VI Organizations
We are USAGing, the national association of Area Agencies on Aging and an advocate for the Title VI Native American aging programs. Our goal is to support aging and community living so that every American can age with best optimal health, well-being, independence and dignity in their homes and communities. We work closely with AAAs and Title VI organizations across the country to understand the needs of their clients, the impact of their programs, their challenges and their evolving best practices. We are a resource to help our members identify innovations and create new opportunities. We advocate on behalf of AAAs and Title VI organizations with policymakers so that they can continue to develop, coordinate and provide essential local services to millions of Americans every day.
Our Name

We refer to ourselves as **USAging**.

When it is helpful for our audiences, we may also include *(formerly n4a, the National Association of Area Agencies on Aging)*.
Brand Identity
Stylescape

This formatted collection of visual elements has been curated to communicate the look and feel of the USAging brand. It contains found imagery of typography, color, imagery, texture, and layout. These samples have been included for inspiration purposes only and should be taken into consideration during the development of future brand collateral.
Introduction to the Logo

USAgeing is helping to drive more inclusive, positive and affirming conversations around aging.

The logo incorporates a modern, sans serif typeface that has been customized to feature additional curved elements. The ‘US’ letters are bolded to reinforce the idea of a stronger community, and to place emphasis on our members and those they serve. The logo functions well in two color, but the weight variation allows for differentiation between the ‘US’ and ‘Aging’ when shown in black and white.

The rounded cross bar of the ‘A’ expands past its confines to connect with the dot in the ‘i’. These elements make the overall mark distinct and ownable for our brand. The gradient color transition within the ‘A’ symbolizes USAging leading the change in the industry.

USAgeing’s logo is the most visible element of your brand’s identity system and is the primary touchpoint to communicate your brand. To ensure the logo maintains its integrity, it may only be treated as designated in these guidelines.
Logo Spacing

The logo exists in a horizontal format and has two additional formats where it may be locked up with a tagline. Examples of these are found on page 25 of this document.

Clear Space

Clear space (defined by X) should be used for all formats of the USAging logo. The (X) distance is the same for all versions.

Minimum Size

Recommendations for minimum logo sizes have been provided for optimal recognition and readability.

Clear Space (X)

should be observed when placing in layout

X is the height of the descending “g” from the baseline at any size

Minimum Size

recommendation for logo is 1.25 inches
Tagline

US Aging’s tagline “Leaders in Aging Well at Home” may be locked up with the logo either to the right or below, shown here.

The tagline must be formatted using the Basic Sans font (Semibold) in the US Aging Blue color. It should be center aligned when shown with the vertical logo and left aligned when shown with the horizontal logo.

For instances where the logo appears in small size formats, the format with the tagline below the logo is recommended.

The tagline must not be altered in any way (font, size, weight, placement) from the specifications listed above.

Minimum Size

Recommendations for minimum logo sizes have been provided for optimal recognition and readability.
Logo Color Formats

The USAging logo should adhere to the following color combinations:

Two Color

The preferred format is Two Color on a white or light background. If the logo is placed on a black or dark background the white version should be used.

Black and White

A full black or full white version of the logo may be used in instances where two color is not an option. The full black logo may also be used on white or light backgrounds. The full white logo may be used on black, purple and other dark backgrounds.

Preferred Format
Two color on light background

Full Black Format
for non-color printing

Full White Format
for use on dark backgrounds
Co-Branding

When locking up the USAging logo with another logo for co-branded events, use a black .5pt line to separate logos. The height of the line should not exceed the height of the USAging logo. Always place the USAging logo to the left of the partner logos. Allow the same amount of clear space on each side of the separator bar.

If taglines are included, it is recommended to use the USAging logo format with the tagline below, as this allows more horizontal space for the partner logo.

It is not recommended to lock up a partner logo above or below the USAging logo.
Use of Logo

Correct and consistent use of the USAging logo will establish and maintain the integrity of the brand.

- Components must not be reconfigured.
- Never alter or distort the logo with graphic treatments.
- Do not use unapproved colors or alter the color usage.
- Logo proportions must not be altered.

Some examples of incorrect usage are shown on the right.
Color Palette

The primary colors of the USAging brand are blue, purple, yellow and white. The colors blue and purple symbolize expertise and authority while yellow warms the palette and creates a friendly tone. White is included to ensure that the brand’s collateral remains clean and light. These colors should be used on branded collateral pieces.

**PANTONE®**

When the printing process allows, always prefer using Pantone® (PMS) spot colors. This will keep color as consistent as possible.

**CMYK**

This color mix can be used as a secondary choice when printing in 4-color process. For the best results, work with your vendor to match the colors indicated in these guidelines.

**RGB & HEX Colors**

These color values are for screen display only, such as web and video.

**Please Note**

Color builds were pulled from the “PANTONE Color Finder” online resource. Please note that RGB & Hex/HTML values will differ between the PANTONE Color Finder and the PANTONE Color Bridge Guides due to different standards for print and digital use.
508 Compliance

Section 508 is an amendment which refers to Section 508 of the Rehabilitation Act of 1973. It is a federal law requiring that all electronic and information technology developed, maintained or used by federal government be accessible to people with disabilities.

Web Content Accessibility Guidelines (WCAG) explains how to make web content more accessible to people with disabilities. WCAG covers websites, applications, and other digital content. It is developed by the World Wide Web Consortium (W3C) Web Accessibility Initiative (WAI). WCAG is an international standard.

There are three levels of conformance:

- Level A is the minimum level.
- Level AA includes all Level A and AA requirements. Many organizations strive to meet Level AA.
- Level AAA includes all Level A, AA, and AAA requirements.

The USAgeing colors have been tested to determine 508 Compliance in regards to color contrast. The results are to the right.

In general, try to use colors that have the most contrast to maintain the best legibility for users.
Logo Anatomy

The USAging logo incorporates a custom gradient color. This gradient may be used sparingly as a complementary design element on collateral pieces. Solid brand color fills are preferred; however, strategic use of the gradient is allowed. The gradient should never appear as a full bleed background or fill large elements in multiple areas of a USAging design. The gradient must not be used on any other letters in the USAging logo other than the A. The gradient within the A may not be changed or altered from the guidelines given in this document.

The USAging gradient colors transition from blue to purple and are pulled from the primary color palette. It is a linear gradient with an angle of 0 degrees. The color transition begins at the start of the last 25% of the gradient bar.

Gradient specification are shown to the right.
Sub-brands

USAgeing has 4 sub-brand logos: Leadership Institute, Answers on Aging, Aging Policy Briefing & Capitol Hill Day, and Aging Innovations & Achievement Awards that have been designed to harness USAgeing’s new parent brand logo as a base. This creates a strong visual connection and consistent brand experience.

Each sub-brand logo has a vertical format (shown on right) and horizontal format (shown on page 33).

New colors that are introduced in the sub-brand logos are specifically for use in the sub-brand and are not for use in any USAgeing parent brand collateral.
Sub-brands continued

For the horizontal format of the sub-brand logos, the mark and the name of the sub-brand are separated by a thin line that corresponds to the color of the sub-brand name. All of the elements are center aligned on their vertical axis.

Clear Space

Clear space (defined by X) should be used for all formats of the USAging sub-brand logos in the horizontal format. The (X) distance is the same for all versions.
Sub-brands
Color Palette

The sub-brand logos for Leadership Institute, Aging Policy & Capitol Hill Day, and Aging Innovations & Achievement Awards incorporate additional colors that are not part of the primary or secondary color palette.

A Bright Blue has been incorporated to the Aging Policy & Capitol Hill Day logo to signify stability and for a professional feel. Gold has been incorporated into the Aging Innovations & Achievement Awards logo to represent golden trophies, medals, or other awards. Bright Purple has been incorporated into the Leadership Institute logo to signify wisdom and to represent a bright future. The Answers on Aging logo uses the same colors as the parent logo because it is the most closely associated with the parent brand.

These colors are specifically for use in the sub-brand and are not for use in any USAging parent brand collateral.

Please Note

Color builds were pulled from the “PANTONE Color Finder” online resource. Please note that RGB & Hex/HTML values will differ between the PANTONE Color Finder and the PANTONE Color Bridge Guides due to different standards for print and digital use.

*The Yellow and Gold logo colors should only be used on design elements to comply with 508 guidance (use USAging blue color for text when designing for the AIAA sub-brand)

<table>
<thead>
<tr>
<th>USAging Brand Guidelines</th>
<th>USAging Brand Guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sub-brands</strong></td>
<td><strong>Color Palette</strong></td>
</tr>
<tr>
<td><strong>USAging</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Answers on Aging</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Blue</strong></td>
<td></td>
</tr>
<tr>
<td>PMS 286 C</td>
<td></td>
</tr>
<tr>
<td>CMYK 100, 80, 0, 12</td>
<td></td>
</tr>
<tr>
<td>RGB 0, 50, 160</td>
<td></td>
</tr>
<tr>
<td>HEX 0032A0</td>
<td></td>
</tr>
<tr>
<td>508 Compliant</td>
<td></td>
</tr>
<tr>
<td><strong>Yellow</strong></td>
<td></td>
</tr>
<tr>
<td>PMS 1225 C</td>
<td></td>
</tr>
<tr>
<td>CMYK 0, 22, 83, 0</td>
<td></td>
</tr>
<tr>
<td>RGB 255, 200, 69</td>
<td></td>
</tr>
<tr>
<td>HEX FFC845</td>
<td></td>
</tr>
<tr>
<td><strong>Gold</strong></td>
<td></td>
</tr>
<tr>
<td>PMS 130 C</td>
<td></td>
</tr>
<tr>
<td>CMYK 0, 32, 100, 0</td>
<td></td>
</tr>
<tr>
<td>RGB 242, 169, 0</td>
<td></td>
</tr>
<tr>
<td>HEX F2A900</td>
<td></td>
</tr>
<tr>
<td><strong>USAging</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Leadership Institute</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Bright Purple</strong></td>
<td></td>
</tr>
<tr>
<td>PMS Purple C</td>
<td></td>
</tr>
<tr>
<td>CMYK 36, 89, 0, 0</td>
<td></td>
</tr>
<tr>
<td>RGB 169, 65, 152</td>
<td></td>
</tr>
<tr>
<td>HEX A94198</td>
<td></td>
</tr>
<tr>
<td><strong>USAging</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Aging Policy Briefing &amp; Capitol Hill Day</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Bright Blue</strong></td>
<td></td>
</tr>
<tr>
<td>PMS 2193 C</td>
<td></td>
</tr>
<tr>
<td>CMYK 86, 21, 0, 0</td>
<td></td>
</tr>
<tr>
<td>RGB 9, 154, 218</td>
<td></td>
</tr>
<tr>
<td>HEX 009ADA</td>
<td></td>
</tr>
<tr>
<td><strong>USAging</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Aging Innovations &amp; Achievement Awards</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Blue</strong></td>
<td></td>
</tr>
<tr>
<td>PMS 286 C</td>
<td></td>
</tr>
<tr>
<td>CMYK 100, 80, 0, 12</td>
<td></td>
</tr>
<tr>
<td>RGB 0, 50, 160</td>
<td></td>
</tr>
<tr>
<td>HEX 0032A0</td>
<td></td>
</tr>
<tr>
<td>508 Compliant</td>
<td></td>
</tr>
<tr>
<td><strong>Bright Purple</strong></td>
<td></td>
</tr>
<tr>
<td>PMS Purple C</td>
<td></td>
</tr>
<tr>
<td>CMYK 81, 99, 0, 0</td>
<td></td>
</tr>
<tr>
<td>RGB 85, 36, 159</td>
<td></td>
</tr>
<tr>
<td>HEX 5F249F</td>
<td></td>
</tr>
<tr>
<td>508 Compliant</td>
<td></td>
</tr>
</tbody>
</table>
Sub-brand Gradients

The sub-brand logos for Leadership Institute, Aging Policy & Capitol Hill Day, and Aging Innovations & Achievement Awards incorporate a new gradient that is not part of the USAging parent brand. These colors are specifically for use in the sub-brand and are not for use in any USAging brand collateral. The gradient is for use in the capital A of the logo mark only. Do not use the gradient on any other letter of the logo or on the mark as a whole.

The gradients for the sub-brand logos are all linear with an angle of 0 degrees. The color transition begins at the start of the last 25% of the gradient bar.

Gradient specifications are shown to the right.
Sponsor Lockups

When locking up the USAging sub-brand logos with one or more sponsor logos, use a .5pt line in the corresponding color of the sub-brand to separate the logos. The height of the line should not exceed the height of the USAging logo. Always place the USAging logo to the left of the partner logos. Allow the same amount of clear space on each side of the separator bar.

The words “Sponsored By” should appear in black, Basic Sans Regular weight centered directly above the sponsor logos.

It is not recommended to lock up a sponsor logo above or below the USAging sub-brand logo.
Typography

Primary Font

The USAging brand uses the Basic Sans font family for designed collateral pieces whenever possible.

Basic Sans is an elegant sans-serif typeface family. Designed with curved elements in mind, this typeface was strategically selected to complement the rounded nature of the wordmark. This font family contains 13 fonts from Thin to Black. The USAging brand exclusively utilizes 8 of those weights within its collateral.

The fonts used in the USAging wordmark is a customized version of another typeface and should not be used in collateral designs.

Secondary Font

The USAging brand uses the Chronicle Text G2 font from Hoefler & Company in its printed collateral as a compliment to Basic Sans.

Chronicle Text G2 is a serif typeface family. The USAging brand exclusively utilizes Roman, Italic, Bold and Bold Italic when designing brand collateral.

Examples of When to Use:

- Printed collateral developed by a graphic designer (publications, brochures, business cards)
- Powerpoints (if the Basic Sans font is pre-loaded onto a staff member’s computer)
- Digital marketing materials developed by a graphic designer (flat advertisements, social media imagery)
Alternate Glyph

When designing collateral for USAging using Basic Sans font, the alternate “g” glyph should be used in place of the default “g” in the alphabet.

Below is a list of the font names that should be installed to ensure the correct “g” is available.

Basic Sans Std Alt Light
Basic Sans Std Light Italic
Basic Sans Std Alt Regular
Basic Sans Std Regular Italic
Basic Sans Std Alt Bold
Basic Sans Std Bold Italic
Basic Sans Std Alt Black
Basic Sans Std Black Italic

See instructions to the right on how to use the Glyph panel in InDesign to change the “g”.

You can also use the Find/Change feature to search for and replace all of the “g” characters in an entire document. To do this go to Edit > Find/Change or use command F.

Go to Window > Type and Tables > Glyph to select the glyph panel.

Once in the glyph panel, make sure you are searching within the Basic Sans font family, you can search for the g character, the alternate g glyph will appear, double click on it to place it into your text frame.

You can also use the Find/Change feature to search for and replace all of the “g” characters in an entire document. To do this go to Edit > Find/Change or use command F.

Once in the Find/Change panel, go to the Glyph tab and set up a query to find the “g” glyph and replace it with the “g”, select “Change All” to replace all of the glyphs in the document.

Be sure that you have “Document” selected next to Search at the bottom of the panel.
Typography Alternatives

When USAging’s brand fonts are not available, the alternative web-safe fonts may be used.

**Alternative Primary Font**

Verdana is a free commercial font that was designed in 1994 for Microsoft. It is a web-safe, sans serif font that will serve as a substitute for Basic Sans when USAging brand fonts are not available.

**Alternative Secondary Font**

Georgia is a serif typeface designed in 1993 for Microsoft. It was intended as a serif typeface that would appear elegant but legible when printed small or on low-resolution screens. It is a web-safe font that will serve as a substitute for Chronicle when USAging brand fonts are not available.

**Examples of When to Use:**

- Web-based collateral such as e-blasts, newsletters, websites, online publications
- Collateral developed using Microsoft Program such as Word, Excel, and Powerpoint (when Basic Sans is not pre-loaded)
A custom pattern design has been provided for use on USAging collateral. The pattern is to be used as a supplement to the USAging brand and to maintain a sense of consistency and cohesion across printed and digital collateral.

All colors within the pattern must be from the primary or secondary USAging color palette. Do not add any additional colors to the pattern. The colors may be individually tinted within the pattern to help with legibility. Examples of tinted versions of the USAging colors are shown to the right. Subtle gradient fades can be added to the edges of the pattern as needed to improve visibility.

The shapes may be rearranged but must never be stretched or distorted.

Be sure there is ample white space spread evenly throughout the pattern to maintain a sense of "lightness."

This gradient pattern is to be used sparingly to corners, edges and areas of large white space that need some of the USAging color palette brought in. **The pattern is not intended to be used as a full background pattern or behind large sections of copy.** The pattern is not intended to be used on every piece of USAging collateral, only when subtle color is needed or to enhance the look and feel of images.

Examples of acceptable use of the USAging pattern can be seen on page 42 and 46 of this document.
Photography

Use of stock photography is permitted when developing collateral for the USAGING brand. When selecting images, please be mindful that the image is not too dark, too muddy, or out of focus. Images should convey a sense of diversity, compassion, warmth, strength, and energy.

Filters that give a sepia or Polaroid appearance should be avoided as it will give the piece a retro and/or dated feel. Images should maintain a bright, caring, and professional essence. When multiple images are being used, please ensure the styles are complementary and the colors are properly balanced. Photos may also be overlaid with color pulled from USAGING’s color palette. Examples of the use of color overlays are shown on the next page of this document.

USAGING uses photography to show the wide range of aging experiences and the aging services, activities, and supports provided by our member agencies. We emphasize what healthy aging looks like at home and in the community, whether that is represented by people with full independence and/or mobility or those who use services and supports to maintain their independence and/or mobility. We show the range of human experiences as we age, but prioritize showcasing older adults who would likely benefit from our members’ services. We minimize our use of photographs in medical settings except where appropriate to the subject or if the medical service depicted could be reasonably assumed to be provided by our member agencies. We avoid depiction of aging services provided in nursing homes or other institutional-based care except where appropriate.
Photography Treatment

Use of color treatments pulled from USAging’s color palette on top of photography is acceptable when developing collateral for the USAging brand.

When using a pattern overlay, please be mindful that you are not covering up or obstructing the subject of the image, such as a person’s face. The pattern overlay (see page 40) should maintain its perfectly square proportions and be placed primarily on the corners and edges of photography.

Full color overlays may also be used on top of images in order to enhance USAging’s brand.

These pattern and full color overlays are using the color layer fill at in Photoshop at 100% opacity and the color effect in InDesign at 100% opacity. The overlay effect should only be used with RGB (for web-based designs) and CMYK (for designs intended to be printed) color builds. The color overlays will not work with PMS color builds.

Examples of acceptable use of pattern and full color overlays are shown on the right.
Design Elements

When designing collateral for USAging, a curved element in the corner or outer edges of the design can be used to enhance the brand. Be sure to use curved elements in a subtle way so as to not overpower the design. Leave plenty of white space to accompany a curved element to avoid weighing the design down.

The size and angle of the curve may vary as needed for the layout. There is not a specific measurement that the curve must adhere to.

See examples to the right.
Collateral Examples

Tote Bag

Office Wall
June 28, 2021

The Honorable Patty Murray, Chair
The Honorable Roy Blunt, Ranking Member
Senate Appropriations Subcommittee on Labor/HHS/Education
Washington, DC 20510

The Honorable Rosa DeLauro, Chair
The Honorable Tom Cole, Ranking Member
House Appropriations Subcommittee on Labor/HHS/Education
Washington, DC 20515

Dear Chairwoman Murray, Ranking Member Blunt,
Chairwoman DeLauro and Ranking Member Cole:

The National Association of Area Agencies on Aging (n4a), which represents the country’s 622 Area Agencies on Aging (AAAs) and advocates for the more than 260 Title VI Native American aging programs, would like to build on our March 25 and April 26 letters to the Committee and express our support for critically important recommendations in President Biden’s FY 2022 budget, specifically increases to the Older Americans Act (OAA) programs and services funded via Title III B Supportive Services, Title III E National Family Caregiver Support Program and Title VI Native American Aging Programs. This letter also addresses our recommendations on the flexibility of OAA funding and an urgent situation on OAA match requirements for the American Rescue Plan.

The OAA is the cornerstone of the nation’s non-Medicaid home and community-based services (HCBS) system, providing older adults with much-needed supports, including in-home care, congregate and home-delivered meals, adult day care, information and referral assistance, case management, transportation, legal services and caregiver support/respite. Investments in these vital OAA programs support the health of older adults with these services and save Medicare—and the nation—money in the short and long-term.

The President’s FY 2022 recommended increases to OAA are particularly welcomed by n4a as our members nationwide have told us that these are the programs most in demand of additional resources to meet the continued and growing needs of older adults and caregivers. The budget request builds upon the Aging Network’s successful pandemic response, which was made possible by substantial supplemental funding provided by Congress. Long-term and widespread social isolation and loneliness among older adults; racial, economic, and geographic inequities; a caregiving workforce in crisis.

Sincerely,

Sandy Markwood
Chief Executive Officer

Marisa Scala-Foley
Director, Aging and Disability
Business Institute
mscala-foley@USAging.org
202.580.6021
pronouns she/her

USAging.org • @theUSAging
Collateral Examples

USAging Brand Guidelines • Brand Identity

USAging Advocacy Alert

FOR MEMBERS AND ALLIES

June 10, 2021

Senators Champion OAA Funding!

Call Your Senators TODAY and Urge Them to Sign On to a Critical OAA Funding Letter!

Senator Bernie Sanders (I-VT) is once again leading the charge to invest in Older Americans Act (OAA) programs that provide essential services to an aging nation. This week the Senator circulated a letter to his colleagues urging them to sign onto a Senate Appropriations Labor/HHS/Education Subcommittee request that doubles FY 2022 funding to $4.25 billion for OAA.

If one of these Senators is yours, please reach out to their office and request they sign on to this letter immediately. The deadline for signatures is Thursday, June 17.

Let them know exactly why you want your Senators to sign on to the OAA letter. Give local statistics that demonstrate the need for an increase in OAA funding. If they ask for a staff member’s name, please provide告诉我 Michaela Brown at MBillger@n4a.org. Your advocacy today, may be a great alternative for those who might be hesitant to call for a doubling of OAA funding.

The following Senators signed on last year but need to hear from you so we can secure their commitment again! Senators: Udall, Hassan, Whitehouse, Blumenthal, Baldwin, Booker, Rosen, Peters, Gillibrand, Stabenow, Warren, Bennet, Markey, Shaheen, Murphy, Casey, Smith, Cardin, Schatz, Booker, Durbin, Grassley, Roybal-Allard, Feingold, Menendez, Brown, Heinrich, Feinstein, Duckworth and Warner.

STEP 1: Reach out to your Senators, their staff or their advisory board members, volunteers and clients to make calls to your Senators today!

STEP 2: Ask other advocates to do the same!

STEP 3: Spread the word in your community to drive more calls!

To date, Senators Cortez Masto, King, Hirono, Reed, Manchin, Merkley, Klobuchar, Booker, Rosen, Peters, Gillibrand, Stabenow, Warren, Bennet, Markey, Shaheen, Murphy, Casey, Smith, Cardin, Schatz, Booker, Durbin, Grassley, Roybal-Allard, Feingold, Menendez, Brown, Heinrich, Feinstein, Duckworth and Warner.

Copyright © 2021 USAging
All Rights Reserved
USAging.org
For questions about how to use the brand guidelines, contact:

Joellen Leavelle
Director, Communications
jleavelle@n4a.org